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Introduction to Microsoft Word
Duration: 8 hours Course
Course Overview: In this course you will learn the necessary skills to create,
edit, format, and print Microsoft Word documents.
Target Audience: This course is intended for students who have little or no
familiarity with Microsoft Word 2019 or more experienced Word users who
want to learn the topics covered in this course in the 2019 interface.
Module 1: Creating a Microsoft Word Document
This module explains how to get started using Microsoft Word.
Lessons
[ Starting Microsoft Word
[] Creating a Document
[] Saving a Document
[J Importing a File
[] The Status Bar
[1 Closing a Document
Lab: Create a Microsoft Word Document
After completing this module, students will be able to:
[] Start Microsoft Word.
[] Create a Microsoft Word document.
[] Save a Microsoft Word document.
[ Use the Status Bar.
[] Close a Microsoft Word document.

Module 2: The Ribbon

This module explains how to work with the Ribbon in Microsoft
Word.

Lessons

[ The Ribbon

[] Tabs

[1 Groups

[1 Commands

Lab: Exploring the Ribbon

After completing this module, students will be able to:
Use tabs.

Use groups.

Use commands.

Understand groups and commands are found on which tabs.
Module 3: The Backstage View

This module explains how to work with the Backstage View.
Lessons

[1 Introduction to the Backstage View

[ Opening a Document

[1 New Documents and Word Templates

[ Configuring Documents to Print

[ Adding Your Name to Microsoft Word

[ Adding Values to Document Properties

[1 Working with Autosaved Versions of Documents
Lab: Backstage View Exercises

Open a Document

Write a Thank You Letter Using a Template Letter
Print a Document

After completing this module, students will be able to:
Learn about the Backstage view.

Open a Microsoft Word document.

Start a new Microsoft Word document.

Use Microsoft Word templates.

Print a Microsoft Word document.

Personalize your copy of Microsoft Word.

Module 4: The Quick Access Toolbar

This module explains how to work with the Quick Access Toolbar in
Microsoft Word.

Lessons
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Adding Common Commands
Adding Additional commands with the Customize Dialog Box
Adding Ribbon Commands or Groups
Placement
Lab: Customize the Quick Access
Toolbar After completing this module,
students will be able to:
Add common commands to the Quick Access Toolbar.
Add additional commands to the Quick Access Toolbar.
Move the Quick Access Toolbar.

Module 5: Formatting Microsoft Word Documents
This module explains how to format Microsoft Word Documents.
Lessons

Selecting Text

Selecting Fonts

Working with Fonts

Working with Lists

Inserting a Hyperlink in a Document

Using Styles

Using Themes

Using the Ruler

Setting Margins

Lab: Formatting Exercises

Working with Fonts

Working with Lists

Inserting a Hyperlink

Applying and Creating Custom Styles

Using Tabs

Setting Margins

After completing this module, students will be able to:
Add, remove, and change fonts in Microsoft Word documents.
Work with lists.

Add hyperlinks in a document.

Apply styles in Microsoft Word documents.

Use themes.

Use the Ruler within Microsoft Word.

Set margins within Microsoft Word.

Module 6: Editing Documents

This module explains how to edit documents in Microsoft Word.

Lessons

Find

Find and Replace

Find and Replace Tips

Appending Text to a Document

Using the Clipboard

Lab: Editing Documents Exercises

Using Find and Replace

Using the Clipboard

After completing this module, students will be able to:

Locate information in your document using Find.

Use Find and Replace to quickly replace words or phrases with other words
or phrases.

Use the Cut, Copy, Paste and Format Painter commands to edit documents.

Module 7: Finalizing Microsoft Word Documents

This module explains how to finalize Microsoft Word Documents.
Lessons

Adding Page Numbers

Headers and Footers

Checking Spelling and Grammar

Lab: Finalizing Microsoft Word Documents Exercises

Adding Page numbers
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Using Headers and Footers
Checking Spelling and Grammar
After completing this module, students will be able to:
Add page numbers to a Microsoft Word document.
Add and customize Headers and Footers.
Find and correct spelling mistakes.
Find and correct grammar mistakes.

Intermediate Microsoft Word

Duration: 8 hours Course

Course Overview: Enroll for this 1-Day Intermediate Microsoft Word 2019
training in which students will learn advanced formatting, use Word 2019
drawing tools, create and manage tables, and work with column layouts.
Target Audience: This course is intended for students who have basic skills
with Microsoft Word 2019 who want to learn intermediate-level skills or
students who want to learn the topics covered in this course in the 2019
interface

Module 1: Advanced Formatting

This module explains how to use advanced formatting techniques in
Microsoft Word.

Lessons

* Shading and Borders

* Setting Line and Paragraph Spacing

* Changing Styles

* Paragraph Marks and Other Formatting Symbols

* Using Formatting Symbols

+ Editing PDF Documents in Microsoft Word

Lab: Advanced Formatting

Exercises

* Using Shading and Borders

* Changing Styles

* Using Formatting Symbols

« Editing PDF Documents and Microsoft Word

After completing this module, students will be able to:

* Use shading and borders to enhance your document.

* Set line and paragraph spacing.

 Format your document using styles.

* Show, hide and use formatting symbols.

* Edit PDFs in Word.

Module 2: Working with Tables

This module explains how to work with tables in Microsoft Word.
Lessons

* Inserting a table

* Table styles

* Formatting a Table

Lab: Working with Tables

Exercises Insert a Table

Adding Styles to a Table

Formatting a Table

After completing this module, students will be able to:

* Insert a table into a document.

*» Format a table using styles.

» Format data within a table.

Module 3: Working with Images

This module explains how to work with images in Microsoft Word.
Lessons

* Inserting Images

* Placing and Sizing Images

» Wrapping Text around an Image

* Adjusting Images

* Borders and Effects

Lab: Working with Images

Exercises

* Insert an Image into a Microsoft Word Document
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* Place and Size an Image in a Microsoft Word Document
* Wrapping Text around an Image
* Adjusting Images in Microsoft Word
» Adding Borders and Effects to Images in Microsoft Word
After completing this module, students will be able to:
* Insert images into a Microsoft Word document.
* Place and size images in a Microsoft Word document.
* Wrap text around images.
* Adjust the look and feel of images.
* Add borders and effects to images.
Module 4: Page Layout
This module explains how to work with page layout options in
Microsoft Word.
Lessons
* Orientation and Paper Size
Using Live Layout and Alignment Guides
Working with Columns
Advanced Formatting
Working with Fields
* Page and Section Breaks
Lab: Page Layout Exercises
« Changing the Page Setup
* Adding Page and Section Breaks
After completing this module, students will be able to:
* Set the page orientation as portrait or landscape.
« Set the print size of the paper.
* To split your text into multiple columns.
* To add page breaks.
* To add section breaks.
Module 5: Working with
[llustrations
This module explains how to work with Illustrations in Microsoft
Word.
Lessons
* Adding and Editing Charts
* Working with Clip Art
* Using Shapes
» Working with Icons
* Working with SmartArt
* Creating Captions
* Using Building Blocks
Lab: Working with Illustrations
Exercises
» Working with Charts
» Working with Clip Art
» Adding Shapes
» Working with Smart Art
* Inserting a Building Block in a Document
After completing this module, students will be able to:
Insert charts into Microsoft Word documents.
Edit charts in Microsoft Word documents.
Use clip art to illustrate your documents.
* Insert shapes into Microsoft Word documents.
* Use SmartArt to illustrate your documents.
* Use captions. Use Word Building Blocks
Module 6: Viewing Your Documents
This module explains how work with viewing options in Microsoft Word.
Lessons
* Document Views
* Using the Navigation Pane
* Multiple Windows
Lab: Viewing Your Documents Exercises
+ Using the Navigation Pane
* Working with Multiple Windows
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After completing this module, students will be able to:
» Show and hide the Navigation pane.
* Use the Navigation pane to quickly get to different sections of your
document.
* Use the Navigation pane to reorganize your document.
* Use the Navigation pane to search within your document.
*» Use multiple windows to view different parts of one document at the
same time.
* Use multiple windows to view multiple documents at the same time.

Advanced Microsoft Word

Duration: 8 hours Course

Course Overview: In this training, students learn advanced techniques, such as working with
tables of contents, footnotes, and endnotes, adding comments, tracking changes, comparing and
combining documents, creating envelopes and labels, using Mail Merge, and protecting
documents. This class is for Word 2019 on Windows.

Target Audience: This course is intended for students who have intermediate skills with Microsoft
Word 2019 who want to learn more advanced skills or students who want to learn the topics
covered in this course in the 2019 interface.

Module 1: Working with Long Documents

This module explains how to work with long documents in Microsoft Word.
Lessons

* Adding a Table of Contents

* Updating the Table of Contents

* Deleting the Table of Contents

* Footnotes and Endnotes

* Inserting citations and a Bibliography

* Adding an Index

* Inserting a Table of Figures

¢ Inserting and Updating a Table of Authorities

* Creating an Outline

Lab : Working with Long Documents Exercises

« Insert and Update a Table of Contents

» Working with Footnotes

* Insert Citations and a Bibliography

After completing this module, students will be able to:

* Add a table of contents to a Microsoft Word document.

* Update the table of contents.

* Add footnotes to a Microsoft Word document.

* Add endnotes to a Microsoft Word document.

« Insert citations into a Microsoft Word document.

* Insert a bibliography.

* Update the bibliography.

» Mark entries in a document.

* Insert an index into a Microsoft Word document.

* Create an outline in Word.

Module 2: Review and Collaborating on Documents

This module explains how to review and collaborate on Microsoft Word documents.
Lessons

* Adding Comments

* Tracking Changes

* Viewing Changes, Additions, and Comments

+ Accepting and Rejecting Changes

Lab : Reviewing and Collaborating Exercises

* Adding Comments to a Document

* Tracking Changes

* Viewing Markup

* Accepting and Rejecting Changes

After completing this module, students will be able to:

* Add and work with comments.

* Track changes and set and change tracking options.

* View changes, additions and comments.

* Use the Reviewing pane.

* Choose what changes to show.
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* Accept and reject changes.
Module 3: Comparing and Combining Documents
This module explains how to compare and combine documents in Microsoft Word.
Lessons
* Comparing Documents
* Combining Documents
Lab : Comparing and Combining Documents Exercises
* Comparing Documents
* Combining Documents
After completing this module, students will be able to:
» Compare documents to find out what has changed between different versions of a
document. Combine documents to gather revisions made by various individuals into a single
document.
Module 4: Managing Mailings
This module explains how to manage mailings in Microsoft Word.
Lessons
* Creating Envelopes and Labels
* Using Mail Merge
Lab : Managing Mailings Exercises
* Printing an Envelope
* Using Mail Merge
After completing this module, students will be able to:
* Create and print envelopes in Microsoft Word.
* Create and print labels in Microsoft Word.
 Use Mail Merge to print or email form letters to multiple recipients. Select mail Merge
recipients from an existing list
Module 5: Protecting Documents
This module explains how to protect documents in Microsoft Word.
Lessons
* Making Word Documents Read Only
* Password Protect Word Documents
* Removing Metadata from Files
* Restrict Formatting and Editing
Lab : Protecting a Document
After completing this module, students will be able to:
» Mark documents as final and make them read only.
* Password protect Microsoft Word documents.
* Restrict formatting options before sharing a document with others.
* Restrict editing options before sharing a document with others
Module 6: Random Useful Items
This module goes over several random and useful features in Microsoft Word.
Lessons
* Using Bookmarks
» Adding Watermarks
» Adding Titles to Sections
* Inserting Built-in Fields
* Using the Go To Feature
» Using Macros
* Copy Macros from Document to Document
* Macro Security
* Recording a Macro
* Assigning Shortcut Keys
* Customizing the Ribbon
* Preparing a Document for Internationalization and Accessibility
* Sharing
Lab : Random Useful Items Exercises
* Using Bookmarks
* Adding Custom Watermarks
* Recording a Macro
* Customizing the Ribbon
* Using the Cloud
After completing this module, students will be able to:
* Add bookmarks to a Microsoft Word document and to use them to jump around the
document.
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» Add watermarks to a Microsoft Word document.
 Add titles to sections.
« Insert built-in fields.
» Use the Go To feature.
* Customize the ribbon.
* Prepare a document for internationalization and accessibility.
¢ Learn how to use the Cloud

Introduction to Microsoft Excel

Duration: 8 hours Course

Course Overview: In this course you will learn the necessary skills to create, edit,
format, and print basic Microsoft Excel 2019 worksheets.
Target Audience: This course is intended for students who have little or no
familiarity with Microsoft Excel 2019 or more experienced Excel users who want
to learn the topics covered in this course in the 2019 interface.
Module 1: Creating a Microsoft Excel Workbook

This module explains how to create and start working with workbooks and
worksheets.

Lessons

Starting Microsoft Excel

Creating a Workbook

Saving a Workbook

The Status Bar

Adding and Deleting Worksheets

Copying and Moving Worksheets

Changing the Order of Worksheets

Splitting the Worksheet Window

Closing a Workbook

Lab : Creating a Microsoft Excel Workbook

After completing this module, students will be able to:

Start Microsoft Excel.

Create a Microsoft Excel workbook.

Save a Microsoft Excel workbook.

Understand the Status Bar.

Add and delete Microsoft Excel worksheets.

Copy and move worksheets.

Split the worksheet window.8. To close a Microsoft Excel workbook.
Module 2: The Ribbon

This module explains how to work with the Ribbon.

Lessons

Tabs

Groups

Commands

Lab : The Ribbon Exercises

Open a Workbook

Select, Open, and Save a Template Agenda

After completing this module, students will be able to:

Work with tabs.

Work with groups.

Work with commands.

Know which groups and commands are found on which tabs.
Module 3: The Backstage View (The File Menu)

This module explains how to work with the Backstage View.
Lessons

Introduction to the Backstage View

Opening a Workbook

Open a Workbook

New Workbooks and Excel Templates

Select, Open and Save a Template Agenda

Printing Worksheets

Print a Worksheet

Adding Your Name to Microsoft Excel
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Adding a Theme to Microsoft Excel
Lab : Backstage View Exercises
Print a Worksheet
Open a Workbook
After completing this module, students will be able to:
Work with the Backstage view.
Open a Microsoft Excel workbook.
Start a new Microsoft Excel workbook.
Use Microsoft Excel templates.
Print a Microsoft Excel workbook.
Personalize your copy of Microsoft Excel
Module 4: The Quick Access Toolbar
This module explains how to work with the Quick Access Toolbar.
Lessons
Adding Common Commands
Adding Additional Commands with the Customize Dialog Box
Adding Ribbon Commands or Groups
Placement
Customize the Quick Access Toolbar
Lab : Customize the Quick Access Toolbar
After completing this module, students will be able to:
Add common commands to the Quick Access Toolbar.
Add additional commands to the Quick Access Toolbar.
Move the Quick Access Toolbar.
Module 5: Entering Data in Microsoft Excel Worksheets
This module explains how to enter data in Microsoft Excel worksheets.
Lessons
Entering Text
Adding and Deleting Cells
Adding a Hyperlink
Add WordArt to a Worksheet
Using AutoComplete
Entering Text and Using AutoComplete
Entering Numbers and Dates
Using the Fill Handle
Entering Numbers and Dates
Lab : Entering Data Exercises
Entering Text and Using AutoComplete
Entering Numbers and Dates
After completing this module, students will be able to:
Enter text in Microsoft Excel worksheets.
Add or delete cells in worksheets.
Add an outline for your data.
Enter a hyperlink in a worksheet.
Use AutoComplete.
Enter numbers and dates in Microsoft Excel worksheets.
Use the Fill Handle to add data to cells.
Module 6: Formatting Microsoft Excel Worksheets
This module explains how to format Microsoft Excel worksheets.
Lessons
Selecting Ranges of Cells
Hiding Worksheets
Adding Color to Worksheet Tabs
Adding Themes to Workbooks
Customize a Workbook Using Tab Colors and Themes
Adding a Watermark
The Font Group
Working with Font Group Commands
The Alignment Group
Working with Alignment Group Commands
The Number Group
Working with Number Group Commands
Lab : Formatting Worksheets Exercises
Customize a Workbook Using Tab Colors and Themes
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Working with Font Group Commands
Working with Alignment Group Commands
Working with Nummber Group Commands
After completing this module, students will be able to:
Understand various ways you can format Microsoft Excel worksheets.
Select a range of cells within a worksheet.
Hide worksheets.
Add color to workbook tabs.
Add themes to worksheets.
Bold, italicize and underline text.
Add borders to cells.
Change text and cell colors.
Change the font and font size.
Align text.
Wrap text.
Indent text.
Merge and center text.
Change number formats.
Change date formats.
Show decimals.
Module 7: Using Formulas in Microsoft Excel
This module explains how to work with formulas in Microsoft Excel.
Lessons
Math Operators and the Order of Operations
Entering Formulas
AutoSum (and Other Common Auto-Formulas)
Copying Formulas and Functions
Relative, Absolute, and Mixed Cell References
Working with Formulas
Lab : Working with Formulas
After completing this module, students will be able to:
Understand math operators and the order of operations in Excel.
Enter basic formulas.
Use AutoSum to sum data with one click.
Understand absolute, relative, and mixed cell references.
Copy formulas and functions.
Module 8: Working with Rows and Columns
This module explains how to work with rows and columns in Microsoft Excel.
Lessons
Inserting Rows and Columns
Deleting Rows and Columns
Transposing Rows and Columns
Setting Row Height and Column Width
Hiding and Unhiding Rows and Columns
Freezing Panes
Working with Rows and Columns
Lab : Working with Rows and Columns
After completing this module, students will be able to:
Insert rows and columns in Microsoft Excel worksheets.
Delete rows and columns in Microsoft Excel worksheets.
Transpose rows and columns.
Change row heights.
Change column widths.
Hide and unhide rows and columns.
Freeze panes.
Module 9: Editing Worksheets
This module explains how to edit worksheets in Microsoft Excel.
Lessons
Find
Find and Replace
Using Find and Replace
Using the Clipboard
Using Format Painter
Managing Comments
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Lab : Editing Worksheets Exercises
Using Find and Replace
Using the Clipboard
Using Format Painter
After completing this module, students will be able to:
Locate information in your worksheet using Find.
Use Find and Replace to quickly replace data with other data.
Use the Cut, Copy, Paste and Format Painter commands to edit worksheets.
Manage comments
Module 10: Finalizing Microsoft Excel Worksheets
This module explains how to finalize Microsoft Excel worksheets.
Lessons
Setting Margins
Setting Page Orientation
Setting the Print Area
Print Scaling (Fit Sheet on One Page)
Printing Headings on Each Page/Repeating Headers and Footers
Headers and Footers
Preparing to Print
Lab : Preparing to Print
After completing this module, students will be able to:
Set margins in Microsoft Excel worksheets.
Set the page orientation to portrait or landscape.
Set the print area in a worksheet.
Scale a worksheet so that all data prints on one page.

Intermediate Microsoft Excel

Duration: 8 hours Course

Course Overview: In this course you will learn advance skill like advanced
formulas, lists, and illustrations. You will also work with charts and advanced
formatting including styles.

Target Audience: This course is intended for students who have basic skills with
Microsoft Excel 2019 who want to learn intermediate-level skills or students who
want to learn the topics covered in this course in the 2019 interface.
Course Outline

Modulel

Lessons

Using Named Ranges in Formulas

Using Formulas That Span Multiple Worksheets

Entering a Formula Using Data in Multiple Worksheets

Using the IF Function

Using the PMT Function

Using the LOOKUP Function

Using the CONCAT

Function

Using the TRANSPOSE Function

Using the PROPER, UPPER, and LOWER Functions

Using the PROPER Function

Using the LEFT, RIGHT, and MID Functions

Using the LEFT and RIGHT Functions

Using Date Functions

Using the YEAR, MONTH, and DAY Functions

Creating Scenarios

After completing this module, students will be able to:

Name and label cells and ranges of cells.

Use names and labels in formulas.

Create formulas that span multiple worksheets.

Use the conditional IF function and its variants in formulas.

Use the PMT function to calculate payments for loans.

Use the LOOKUP function.

Use the VLOOKUP function.

Use the HLOOKUP function.

Use the CONCAT function to join the contents of numerous cells.
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Use the TRANSPOSE function.
Use the PROPER, UPPER, and LOWER functions to alter the casing of text.
Use the LEFT, RIGHT, and MID functions to return characters from the start or
end of a string, or a specific number of text characters.
Use various date functions.
Converting a List to a Table
Removing Duplicates from a List
Sorting Data in a List
Filtering Data in a List
Adding Subtotals to a List
Lab : Work with Lists Exercises
After completing this module, students will be able to:
Convert data into tables.
Remove duplicates from tables.
Sort data in Excel.
Filter data in Excel.
Use subtotals to automatically total related data.
Group and ungroup data.
Module 3: Working with Illustrations
This module explains how to work with Illustrations in Microsoft
Excel.
Lessons
Lab : Working with Illustrations Exercises
After completing this module, students will be able to:
Add pictures to your worksheets.
Use Clip Art to illustrate your worksheets.
Insert shapes into Microsoft Excel worksheets. Use SmartArt to illustrate your
worksheets.
Inserting Charts
Using the Chart Recommendation Feature
Editing Charts
Using Chart Tools
Using the Quick Analysis Tool
Add and Format Objects
Create a Custom Chart Template
Lab : Visualizing Your Data Exercises
After completing this module, students will be able to:
Create charts that enable you to visualize your data.
Choose what data is displayed in your charts.
Show and hide data labels.
Show and hide the legend.
Show and hide the chart title.
Add a picture or shape to a chart.
Change the way text displays in a chart.
Change the fill color of a chart.
Add and format objects in a worksheet.
Create a custom chart template.
Format Data as a Table
Move between Tables and Ranges
Modify Tables
Define Titles
Creating and Modifying a Table in Excel
Lab : Creating and Modifying a Table in Excel
After completing this module, students will be able to:
Format data in Excel as a table.
Modify Excel tables
This module helps in understanding conditional formatting in Microsoft Excel
Applying Conditional Formatting
Using Conditional Formatting
Working with Styles
Creating and Modifying Templates
Lab : Advanced Formatting Exercises
After completing this module, students will be able to:
Use conditional formatting to display cells differently based on their values.
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Quickly format tables using styles.
Format cells using styles

Advanced Microsoft Excel

Duration: 8 hours Course

Course Overview: This Advanced Microsoft Excel 2019 training class is designed
for students to gain the skills necessary to use pivot tables, audit and analyze
worksheet data, utilize data tools, collaborate with others, and create and
manage macros.

Target Audience: Students who have intermediate skills with Microsoft Excel
2019 who want to learn more advanced skills or students who want to learn the
topics covered in this course in the 2019 interface.

Course outline

Module 1: Using Pivot Tables

This module explains how to use pivot tables in Microsoft Excel.
Lessons

* Creating Pivot Tables

* More PivotTable Functionality

* Inserting Slicers

» Multi-Select Option in Slicers

* PivotTable Enhancements

» Working with Pivot Tables

* Inserting Pivot Charts

* More Pivot Table Functionality

» Working with Pivot Tables

Lab : Working with Pivot Tables

After completing this module, students will be able to:

* Use pivot tables to analyze data.

« Edit pivot tables.

 Format pivot tables.

* Insert pivot charts.

* Use Slicers.

Module 2: Auditing Worksheets

This module explains how to audit worksheets.

Lessons

* Tracing Precedents

* Tracing Dependents

» Showing Formulas

Lab : Auditing Worksheets Exercises

* Tracing Precedents

* Tracing Dependents

After completing this module, students will be able to:

* Audit formulas.

* Trace precedents to determine which cells impact a specific cell.
* Trace dependents to determine which cells are impacted by a
specific cell.

» Remove precedent and dependent arrows.

* Show formulas.

* Check for errors frequently found in formulas

Module 3: Data Tools

This module explains how to work with data tools.

Lessons

* Converting Text to Columns

* Linking to External Data

* Controlling Calculation Options

* Data Validation

* Using Data Validation

* Consolidating Data

* Goal Seek

* Using Goal Seek

Lab : Data Tools Exercises

* Converting Text to Columns

* Using Data Validation
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* Consolidating Data
* Using Goal Seek
After completing this module, students will be able to:
* Convert text to columns.
* Use Data Validation to restrict the type of data that can be entered
into a cell.
* Consolidate data from a number of different ranges into one new
range.
* Use Goal Seek to figure out the value to input to obtain a specific
result
Module 4: Working with Others
This module explains how work with others in Microsoft Excel.
Lessons
* Protecting Worksheets and Workbooks
* Password Protecting a Workbook
* Password Protecting a Worksheet
* Password Protecting Ranges in a Worksheet
» Marking a Workbook as Final
Lab : Working with Others Exercises
* Password Protecting a Workbook
* Passsword Protecting a Worksheet
* Password Protecting Ranges in a Worksheet After completing
this module, students will be able to:
« Password protect a workbook.
* Password protect a worksheet.
* Password protect ranges in a worksheet.
* Track changes.
* Accept and reject changes.
* List all changes on a new sheet
Module 5: Recording and Using Macros
This module explains how record and use macros.
Lessons
* Recording Macros
* Recording a Macro
* Running Macros
« Editing Macros
* Adding Macros to the Quick Access Toolbar
* Adding a Macro to the Quick Access Toolbar
Lab : Recording and Using Macros
Exercises
* Recording a Macro
* Adding a Macro to the Quick Access Toolbar After completing
this module, students will be able to:
* Record macros.
* Run macros.
* Edit macros (kind of).
* Add macros to the Quick Access Toolbar
Module 6: Random Useful Items
This module explains how to use sparklines and other useful random
features.
Lessons
* Sparklines
* Inserting and Customizing Sparklines
* Using Microsoft Translator
* Preparing a Workbook for Internationalization and Accessibility
* Importing and Exporting Files
* Importing Text Files
* Copying Data from Excel to Word
* Copying Charts from Excel to Word
Lab : Random Useful Items Exercises
* Inserting and Customizing Sparklines
* Importing Text Files
* Copying Data from Excel to Word
* Copying Charts from Excel to Word
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After completing this module, students will be able to:
* Insert sparklines into worksheets.
* Customize sparklines by:
* Change the type of sparkline.
* Highlight key points.
* Change colors.
* Change the axis.
* Prepare a workbook for internationalization, accessibility, and
compatibility.
* Import text files into Microsoft Excel.
* Copy cells from a worksheet into Microsoft Word. Copy and paste a
chart into Microsoft Word.
Module 7: Cloud
This module explains how to save, share, and collaborate with others using
the cloud.
Lessons
* Using the Cloud.
Lab : Using the Cloud
After completing this module, students will be able to:
Use Excel in the Cloud.

Introduction to Microsoft PowerPoint

Duration: 8 hours Course

Course Overview: In this course you will learn the fundamentals

skills needed to create and modify basic presentations using

Microsoft Office PowerPoint.

Target Audience: Students who have little or no familiarity with

Microsoft PowerPoint 2019 or more experienced Word users who

want to learn the topics covered in this course in the 2019

interface.

Module 1: Creating a PowerPoint Presentation

This module explains how to create a presentation in Microsoft PowerPoint.
Lessons

« Starting Microsoft PowerPoint

* Normal View

* Creating a Presentation

* Saving a Document

* Importing a File

* The Status Bar

* Closing a Presentation

Lab : Creating a Microsoft PowerPoint Presentation

After completing this module, students will be able to:

« Start Microsoft PowerPoint.

* Learn about Normal view.

* Create a PowerPoint presentation.

* Save a PowerPoint presentation.

* Import a file into PowerPoint.

 Learn about the Status Bar. Close a PowerPoint presentation Module 2: The Ribbon
This module explains how to work with the Ribbon in Microsoft PowerPoint.
Lessons
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* The Ribbon
* Tabs
* Groups
* Commands
* The Tell Me Tab
Lab : Exploring the Ribbon
After completing this module, students will be able to:
* Work with tabs, groups, and commands
* Learn which group and commands are found on which tabs. Module 3:
The Quick Access Toolbar
This module explains how to work with the Quick Access Toolbar in Microsoft
PowerPoint.
Lessons
* Adding Common Commands
* Adding More Commands with the Customize Dialog Box
* Adding Ribbon Commands or Groups
* Placement
Lab : Customizing the Quick Access Toolbar
After completing this module, students will be able to:
* Add common commands to the Quick Access Toolbar.
* Add additional commands to the Quick Access Toolbar.
Move the Quick Access Toolbar.
Module 4: The Backstage View (The File Menu)
This module explains how to work with the Backstage View in Microsoft PowerPoint.
Lessons
* Introduction to the Backstage View
* Opening a Presentation
* New Presentations and Presentation Templates
* Presentation Properties
* Adding Your Name to Microsoft PowerPoint Lab : Backstage View Exercises
* Opening a Presentation
* Creating an Agenda Using a Template
After completing this module, students will be able to:
* Use the Backstage view.
* Open a Microsoft PowerPoint presentation.
« Start a new Microsoft PowerPoint presentation.
* Use Microsoft PowerPoint templates.
* Modify presentation properties.
* Personalize your copy of Microsoft PowerPoint.
Module 5: Formatting Microsoft PowerPoint Presentations
This module explains how to format Microsoft PowerPoint presentations.
Lessons
* Selecting a Slide Layout
» Adding Text
* Adding Text from a Text File or Word Outline
* Editing Text
* Formatting Text
* Formatting Text as WordArt
* Creating Bulletted and Numbered Lists
* Ink Equation
* Formatting Text Placeholders
* Adding Slides to a Presenations
* Arranging Slides
Lab : Formatting Text
After completing this module, students will be able to:
* Select a slide layout.
» Add text to a slide.
+ Import content from a text file outline.
* Edit text.
* Format text.
* Format text placeholders.
* Apply styles to slides.
* Add slides to a presentation.
* Delete slides from a presentation.Learn to arrange slides. Module 6: Working with
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Images
This module explains how to work with images in Microsoft PowerPoint.
Lessons
* Adding Images to a Slide
* Inserting a Picture
* Inserting Icons
* Inserting Clip Art
* Capturing and Inserting a Screenshot
+ Editing an Image
* Formatting Images
* Creating Custom Color with the Eyedropper
* Applying a Style and Cropping an Image
* Arranging Images
* Adding Shapes
* Using Digital Ink
Lab : Working with Images and Shapes
After completing this module, students will be able to:
* Add images to a presentation.
* Insert a picture.
* Insert clip art.
« Insert a screenshot.
* Edit an image.
* Rotate and resize an image.
* Group and ungroup images.
* Arrange images.
* Add shapes.
Module 7: Working with Tables and Charts
This module explains how to work with tables and charts in Microsoft PowerPoint.
Lessons
* Inserting a Table
* Formatting Tables
* Importing Tables from Exertal Sources
* Inserting a Chart
* Formatting a Chart
* Importing Charts from Exertnal Sources
Lab : Working with Tables and Charts Exercises
» Working with a Table
» Working with Charts
After completing this module, students will be able to:
* Insert a table in a slide.
* Format a table.
* Copy a table from other Microsoft Office applications into PowerPoint.
* Insert a chart in a slide.
* Format a chart.
* Copy a chart from other Microsoft Office applications into PowerPoint.
Module 8: Finalizing Microsoft PowerPoint Presentations
This module explains how to finalize Microsoft PowerPoint presentations.
Lessons
* Checking Spelling
* Accessing Differnt Views of a Presentation
* Organizing a Presentation in Sections
* Adding Transitions to Slides
* Adding Speaker Notes
* Running a Slide Show
* Printing a Presentation
Lab : Finalizing Presenation Exercises
* Viewing the Presenation
* Finalizing Your Presenation
After completing this module, students will be able to:
* Check spelling in your presentation.
* Access different views of a presentation.
* Divide a presentation into different sections.
* Add transitions to a slide.
* Add speaker notes.
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* Run a slide show.
* Print a presentation

Advanced Microsoft PowerPoint

Duration: 8 hours Course

Course Overview: This Advanced Microsoft PowerPoint 2019 training class is for
PowerPoint 2019 users who want to build upon their basic skills. Students will use
advanced techniques such as working with Masters and Special Effects within their
presentations.

Target Audience: Students who have basic skills with Microsoft PowerPoint 2019 who
want to learn advanced-level skills or students who want to learn the topics covered in
this course in the 2019 interface.

Course outline

Module 1: Customizing Presentations

This module explains how to customize presentations in Microsoft PowerPoint.
Lessons

* Applying a Theme

* Applying a Background Style

* Adding a Footer

* Arranging and Printing Sections

Lab : Customizing Presentations Exercises

* Adding a Background Image

* Customizing Your Presentation

After completing this module, students will be able to:

* Apply a theme.

* Apply a background style.

* Add a footer.

* Add a background image.

* Save a custom theme.

* Arrange and print sections of a presentation.

Module 2: Presentation Masters

This module explains how to work with presenatation masters in Microsoft Power. L
Lessons

Working with the Slide Master

« Slide Layouts

* Formatting Slide Masters and Layouts

* Adding a Watermark to Your Presentation

* Adding Slide numbers Using the Slide Master

* Preserving a Slide Master

Modifying the Handout Master

Adding a Header and Footer to Notes and Handouts Lab
: Using the Slide Master

After completing this module, students will be able to:

* Work with the slide master.

* Work with layouts.

* Format slide masters and slide layouts.

* Add a watermark.

* Add slide numbers.

* Insert a new slide master.

* Preserve a slide master.

* Modify the notes master.

* Modify the handout master.

* Add a header and footer to notes and handouts.
Module 3: Working with Special Effects

This module explains how to work with special effects in Microsoft PowerPoint.
Lessons

* Animating Text and Objects

* Motion Paths

» Working with the Animation Painter

* Setting Animation Timing

» Animating a Chart

Lab : Applying Special Effects to a Presentation After completing
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this module, students will be able to:
» Animate text and objects.
* Work with the Animation Painter.
* Set animation timing.
* Animate a chart.
Module 4: Using SmartArt
This module explains how to use SmartArt in Microsoft PowerPoint.
Lessons
* Inserting SmartArt Graphics
* Modifying SmartArt Graphics
* Resizing/Repositioning a SmartArt Object
* Formatting Text in a SmartArt Object
* Adding Shapes to a SmartArt Object
» Ungrouping SmartArt Objects
Lab : Working with SmartArt
After completing this module, students will be able to:
* Insert SmartArt graphics into your presentations.
* Modify SmartArt graphics.
* Resize and reposition SmartArt graphics.
* Add text to a SmartArt object.
* Format text within a SmartArt object.
* Add shapes to a SmartArt graphic.
» Ungroup SmartArt objects.
Module 5: Multimedia
This module explains how work with multimedia in Microsoft PowerPoint.
Lessons
* Creating a Photo Album
* Adding Captions
* Applying a Theme to Your Album
* Customizing an Album
* Inserting Sounds and Video
* Editing Media Clips
Lab : Multimedia Exercises
* Creating and Modifying a Photo Album
» Adding Video to a Presentation
After completing this module, students will be able to:
* Create a photo album.
* Add captions to photos in an album.
* Apply a theme to an album.
Customize the photo album layout.
Insert sound and video in a presentation.
Edit media clips in PowerPoint.
To change multimedia settings. Module
6: Setting Up the Slide Show
This module explains how to set up a slide show in Microsoft PowerPoint.
Lessons
* Setting Up a Ccustom Show
* Creating a Hyperlink
* Adding an Action Button
+ Jumping to Another Presentation
* Using Rehearse Timings
* Navigating within a Slide Show
* Annotating a Presentation
* Recording a Slide show
* Setting Up a Slide Show to Repeat Automatically
Lab : Setting Up the Slide Show Exercises
* Presenting a Custom Show
* Preparing the Slide Show
After completing this module, students will be able to:
* Set up a custom slide show.
¢ Create a hyperlink.
* Add an action button.
* Jump to another presentation.
* Rehearse the timing of your presentation.
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* Navigate within a slide show.
* Annotate a presentation.
* Create a presenter-independent slide show.
* Set up a slide show to repeat automatically.
Module 7: Outlines and Slides
This module explains how to work with outlines and slides in Microsoft PowerPoint.
Lessons
Exporting Notes and Handouts to Word
Exporting an Outline to Word
Saving a Presentation as an Outline
Saving a Slide as an Graphic
Lab : Exporting an Outline to Word
After completing this module, students will be able to:
* Export notes and handouts to Word documents.
« Export an outline to a Word document.
* Save your presentation as an outline.
* Save a slide in your presentation as a graphic.
Module 8: Managing Multiple Presentations
This module explains how to manage multiple presentations.
Lessons
» Merging Multiple Presentations
* Reusing Slides from Other Presentations
* Viewing Multiple Presenations
* Tracking Changes in PowerPoint
Lab : Reviewing Changes in PowerPoint
After completing this module, students will be able to:
* Merge multiple presentations.
* Reuse slides from other presentations.
* View multiple presentations.
* Track and manage changes in PowerPoint.
Module 9: Sharing and Securing a Presentation
This module explains how to share and secure a presentation in Microsoft PowerPoint.
Lessons
« Sharing a Presentation with Remote Audience
* Embedding the Fonts in a Presentation
* Inspecting the Presentation
* Using Comments
* Packaging a Presentation for CD
Using the PowerPoint Viewer
Encrypting a Presentation
Adding a Digital Signature
» Marking a Presenation as Final
» Compressing Pictures
* Sending a Presenation iin PDF Format
Lab : Sharing and Securing Exercises
* Sharing a Presentation
* Securing a Presentation
After completing this module, students will be able to:
* Share your presentation with a remote audience.
* Embed fonts in a presentation.
* Inspect the presentation.
* Package your presentation for a CD.
* Use PowerPoint Viewer.
* Save your presentation for web viewing.
* Encrypt your presentation.
* Add a digital signature to your presentation.
* Grant permissions.
» Compress the pictures in your file.
* Send your presentation in PDF format.

Introduction to Microsoft Outlook

Duration: 8 hours Course
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Course Overview: In this course you will learn about Outlook 2019 interface and
working with messages, calendars, and contacts.
Target Audience: Students who have little or no familiarity with Microsoft Outlook
2019 or more experienced Outlook users who want to learn the topics covered in this
course in the 2019 interface.
Course outline
Module 1: The Outlook 2019 Interface
This module explains how to work with the Outlook 2019 interface.
Lessons
Overview of the Outlook Interface
The Ribbon
Tabs, Groups, and Commands on the Ribbon
The Backstage View
Lab : Outlook Interface Exercises
Exploring the Ribbon
Exploring the Backstage View
After completing this module, students will be able to:
Work with the Microsoft Outlook interface.
Work with the Outlook Ribbon.
Work with the tabs, groups, and commands on the Ribbon.
Work with the Backstage view.
Module 2: Performing Popular Tasks in Outlook 2019
This module explains how to perform popular tasks in Outlook 2019.
Lessons
Setting Up an Email Account
Open Email Messages
Reply to and Forward Email Messages
Preview and Save an Attachment
Print a Message
Delete a Message
Save a Message in an Alternate Format
Delegate Access
Customize the Navigation Pane
Lab : Performing Popular Tasks Exercises
Setting Up an Email Account
Opening and Replying to a Message
Printing a Message
After completing this module, students will be able to:
Set up an email account in Outlook.
Open email messages.
Reply to and forward email messages.
Print and save an attachment.
Print messages.
Delete messages.
Save a message in an alternate format.
Delegate access.
Customize the Navigation Pane.
Module 3: Working with Messages
This module explains how to work with messages in Microsoft Outlook.
Lessons
Compose a Message
Add an Attachment
Add Voting Options
Check Spelling and Grammar
Format Text
Use Microsoft Word to Edit Messages
Insert a Hyperlink or Image to a Message
Send a Message
Lab : Creating and Sending a New Message
After completing this module, students will be able to:
Compose a message.
Add an attachment to a message.
Add voting options to a message.
Check the spelling and grammar in a message.
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Format text.
Use Microsoft Word to edit email messages.
Insert a hyperlink in a message.
Send a message.
Module 4: Working with the Calendar
This module explains how to work with the calendar in Microsoft Outlook.
Lessons
Change Your Calendar View
Set Up Availability Status
Print Your Scedule
Share Your Calendar
Schedule a Meeting
Make Updates to Meetings
Cancel a Metting
Reply to a Meeting Invitation
Schedule an Appointment
Make Upates to an Appointment
Create Calendar Groups
Delete a Calendar
Work with Calendar Items
Create and Add Calendars
Lab : Working with the Calendar Exercises
Setting Up Your Calendar
Scheduling a Meeting
After completing this module, students will be able to:
Change your Calendar View.
Set up availability status.
Set up your calendar availability.
Print your schedule.
Schedule a meeting.
Make updates to meetings.
Reply to a meeting invitation.
Schedule an appointment.
Make updates to an appointment.
Create calendar groups.
Delete a calendar.
Work with calendar items.
Use multiple calendars.
Module 5: Organzing Contacts
This module explains how to organize contacts in Microsoft Outlook.
Lessons
Add, Delete, Import, and Print a Contact
Update a Contact
Locate a Contact
Sort Contacts
Work with Contact Groups
Manage Multiple Address books
Perform a Mail Merge
Lab : Organizing Contact Exercises
Adding and Updating a Contact
Performing a Mail Merge
After completing this module, students will be able to:
Add a contact.
Update a contact.
Share a contact.
Locate contacts.
Sort and find contacts.
Work with contact groups.
Work with multiple address books.
Perform a mail merge.

Advanced Microsoft Outlook

Duration: 8 hours Course
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Course Overview: This Microsoft Outlook training class builds on basic skills in Outlook
and teaches students to work with some of the more advanced features of Outlook.
Target Audience: This course is intended for students who have basic skills with
Microsoft Outlook 2019 who want to learn higher level skills or students who want to
learn the topics covered in this course in the 2019 interface.
Module 1: Working with Tasks and Notes
This module explains how to work with tasks and notes in Microsoft Outlook.
Lessons
Create a Task
Print a Task
Update a Task
Search for Tasks
Assign a Task
Reply to a Task Request
Track Tasks
Change Your Task View
Work with Notes
Lab : Work with Tasks
After completing this module, students will be able to:
Change your Task view.
Create a task.
Print a task.
Update a task.
Assign a task.
Search for tasks.
Reply to a task request.
Track tasks.
Work with notes.
Module 2: Using Signature and Themes
This module explains how to use signatures and themes.
Lessons
Create a Signature
Automatically Add a Signature to Messages
Modify a Signature
Format Outgoing Messages
Create and Apply a Theme
Lab : Adding a Theme and Signature to Your Messages
After completing this module, students will be able to:
Create a signature.
Learn how to automatically add the signature to email messages.
Modify a signature.
Create and apply a theme
Module 3: Managing Your Inbox
This module explains how to manage your inbox in Microsoft Outlook.
Lessons
Search for Messages
Create Search Folders
Sort Messages
Add New Local Folders
Move Messages between Folders
Group Your Mailbox Items
Filter Messages
Organize Messages
Create and Manage Rules
Manage Your Junk Email
Acrhive Your Messages
Create an Outlook Data File
Create a Quick Step
Add Protection to Your Outgoinng Messages
Create Auto-replies
Lab : Managing Your Inbox Exercises
Organizing Your Messages
Managing Your Mail by Creating a Quick Step
After completing this module, students will be able to:
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Search for messages.
Create search folders.
Group your mailbox items.
Filter messages.
Organize messages.
Manage your junk mail.
Archive your messages.
Create an Outlook data file.
Create a Quick Step to easily and quickly apply multiple actions to emails. Add protection
to outgoing emails.
Module 4: Working with Multiple Email Accounts
This module explains how to work with multiple email accounts in Microsoft
Outlook.
Lessons
Setting Up Multiple Accounts in Outlook
Send Emails from Different Accounts
POP vs. IMAP Email Programs
Lab : Working with Multiple Email Accounts
After completing this module, students will be able to:
Set up multiple accounts in Outlook.
Send emails from different accounts.
Learn the differences between POP and IMAP email programs.

Microsoft Access
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Module 7: Reports
[ Reports
[J Report Wizard
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[ Database Defines
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[ RDBMS Defined
[J Creating a Relationship
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[] Alter a Form
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Module 14: Macros
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[ Running a Macro
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